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1. WYMOGI BEZPIECZEŃSTWA 

 
 

Poniższe wymogi bezpieczeństwa nie zawierają wszystkich informacji dotyczących działania 

urządzenia. Należy się zapoznać z niniejszą instrukcją obsługi w całości! 

 

UWAGA: Wszelkich podłączeń i zmian należy dokonywać przy odłączonym napięciu 

zasilającym. 

 

UWAGA:  Instalacja oraz programowanie urządzenia wymagają posiadania odpowiednich 

umiejętności, dlatego mogą być dokonywane tylko przez wykwalifikowany 

personel po zapoznaniu się z całą instrukcją obsługi. 

 

UWAGA:  W przypadku, gdy urządzenie ulegnie uszkodzeniu, należy skontaktować się ze 

sprzedawcą lub osobą odpowiedzialną za instalację.  
 

UWAGA:  Nieprawidłowo podłączone urządzenie może ulec uszkodzeniu. 

 

UWAGA:  Odpowiedzialność za prawidłową instalację urządzenia spoczywa na osobie 

montującej. Należy się upewnić czy spełnione zostają wszystkie wytyczne i normy 

obowiązujące w danym kraju.  

 

UWAGA: Wyładowania elektrostatyczne mogą uszkodzić urządzenie. Należy stosować 
odpowiednie zabezpieczenie. 

 

UWAGA: Wszelkie nieautoryzowane przeróbki, modyfikacje oraz próby naprawy powodują 
utratę gwarancji.  
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2. Wstęp 

 
Moduł MCT-1 służy do pomiaru temperatury w od 1 do 4 punktach, w zakresie -40ºC do +85ºC. 

Rozdzielczość pomiaru temperatury wynosi 0.1ºC, a dokładność pomiaru maksymalnie ±0.5ºC. 

Średnia dokładność pomiaru jest mniejsza niż ±0.2ºC. Moduł może być zasilany napięciem od 9 do 

24V prądu stałego (DC). Maksymalny pobór prądu wynosi 100mA. Wymiary modułu pozwalają na 

zmieszczenie go w standardowej puszce instalacyjnej. 

 

 
Rys. 1. Widok modułu MCT-1 

 

 

3. Dane techniczne 

 
 

Tabela 1. Parametry graniczne 

Nazwa parametru Uwagi Min. Max. 

Napięcie zasilania 

24VDC 
Notka 1  35VDC 

Temperatura Notka 1 -20ºC 90ºC 

Napięcie na 

wyprowadzeniach 

SDA, SCL 

 -0.7VDC 6VDC 

 

 

Notka 1: Przekroczenie parametrów granicznych może spowodować uszkodzenie urządzenia, lub/i 

trwałe obniżenie parametrów. Długotrwała praca w warunkach bliskich parametrom granicznym 

może spowodować nieprawidłowe działanie układu, a nawet uszkodzenie urządzenia. 

 

 

 

 



 

 5 

 

Tabela 2. Rekomendowane warunki pracy 

Nazwa parametru Uwagi Min. Typ. Max. 

Napięcie zasilania 

24VDC 
 9VDC 24V 32VDC 

Prąd zasilania 24VDC   50mA 100mA 

Napięcie na 

wyprowadzeniach 

SDA, SCL 

 0VDC  5.1VDC 

Temperatura pracy  -40ºC  80ºC 

Wilgotność Notka 1 5%  95% 

Wysokość  0m n.p.m.  2000m n.p.m. 

Notka 1: Wilgotność bez kondensacji! 

 

4. Instalacja 

4.1 Obwód elektryczny 
 

 
        Rys. 2. Rozmieszczenie elementów na płytce modułu 

U2 – CPU 

D1..D3 – diody LED sygnalizujące stan urządzenia 

SW1 – przełącznik konfigurujący prędkość komunikacji, adres płytki oraz 

tryb Modbus 
 

Uwaga: Podłączanie niezgodne z instrukcją może spowodować nieprawidłową pracę i/lub 

uszkodzenie urządzenia nie objęte gwarancją! 
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     Tabela 3. Złącze J2: 

 

Numer pinu Nazwa Opis 

1 +V Plus zasilania 

2 GND Minus zasilania 

3 D- Interfejs RS-485 

4 D+ Interfejs RS-485 

5 Vcc Plus zasilania czujników 

6 DQ Linia danych czujników 

7 NC nieużywane, nie podłączać! 

8 GND Minus zasilania czujników 

     

 

Tabela 4. Diody sygnalizacyjne: 

Nr diody Kolor Nazwa Opis 

D1 zielony RX Sygnalizuje odbieranie, jeśli miga 

D2 czerwony TX Sygnalizuje nadawanie, jeśli miga 

D3 czerwony CPU 

Zmiana stanu diody (świeci → nie 

świeci, nie świeci → świeci) sygnalizuje 

wykonanie pomiaru i poprawną pracę 
CPU 

Uwaga: Na module zamiast diod czerwonych mogą być zamontowane diody 

pomarańczowe 

 

 

Nieprzerwane świecenie się diod RX i TX sygnalizuje możliwość błędu w podłączeniu sygnałów 

do gniazda. Miganie tylko diody sygnalizującej odbieranie danych przez moduł sygnalizuje 

możliwość wysyłania błędnego adresu, lub wybranie błędnych parametrów transmisji 

(nieprawidłowa prędkość, ustawienia parzystości, liczba bitów stopu, itp.) 

 

 

 

4.2  Przykład podłączenia elektrycznego 
 
 
Poniższy rysunek przedstawia schemat typowego podłączenia układu do magistrali RS-485. Moduł 

pomiaru temperatury można zasilać napięciem stałym z zakresu 9...24V. Do układu można 

podłączyć maksymalnie 4 czujniki temperatury DS18B20. Wszystkie należy podłączyć do tych 

samych wyprowadzeń (tj. 5, 6, 8) w sposób widoczny poniżej. Połączenie czujników do modułu 

musi być wykonane kablem nieekranowanym. 

 

 

Komunikacja modułu z innymi urządzeniami realizowana jest z wykorzystaniem interfejsu RS-485. 

Przewody należy podłączyć według rysunku (rys. 2). Moduł może pracować tylko jako urządzenie 

slave. Przełącznikiem SW1 ustala się adres fizyczny urządzenia, prędkość komunikacji oraz tryb 

Modbus, co zostanie opisane w dalszej części instrukcji.  
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Rys. 3. Przykład podłączenia modułu pomiaru temperatury MCT-1 

 

 

 

W kablu od czujnika może występować przewód o kolorze zielonym i jest on zamienny 

z niebieskim, tzn. może wystąpić kombinacja: czerwony - biały - niebieski lub czerwony - biały - 

zielony. 
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4.3  Ustawianie prędkości, adresu i trybu Modbus 
 

 
 

Rys. 4. Switch SW1 do ustawiania adresu Modbus (zworki 1-6).  

Na rysunku przedstawiono 31 z 63 możliwych ustawień adresu. 

 

W położeniu przedstawionym na widoku płytki, zworka w pozycji OFF oznacza 1, zworka 

w pozycji ON – 0.  

 

W switchu SW1 zworki 1..6 służą do ustawienia adresu w protokole Modbus (A0..A5) modułu 

pomiaru temperatury: 

1 – A0 (najmniej znaczący bit adresu - LSB) 

2 – A1 

3 – A2 

4 – A3 

5 – A4 

6 – A5 (najbardziej znaczący bit adresu - MSB) 

 

Adres modułu pomiaru temperatury w protokole Modbus: 

- ustala się sprzętowo za pomocą switcha SW100,  

- może przyjmować wartości 1..63,  

- adres 0 jest zarezerwowany w specyfikacji protokołu Modbus jako rozgłoszeniowy (broadcast),  

- ustawia się w postaci binarnej, tzn. 27 (dec) = 011011 (bin). Switch w pozycji ON oznacza bit 

adresu ustawiony jako 0. Switch w pozycji OFF oznacza bit adresu ustawiony jako 1.  
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4.3.1. Ustawianie trybu Modbusa za pomocą switcha SW1 

 

 
Zworka 7 (z zestawu SW1) służy do ustawiania trybu Modbusa. 

0 – Modbus RTU 

1 – Modbus ASCII  

 

4.3.2. Ustawianie prędkości transmisji za pomocą switcha SW1 
 

Zworka 8 (z zestawu SW1) służy do ustawiania prędkości transmisji: 

0 – prędkość 9600 baud  

1 – prędkość 57600 baud 

 

Uwaga: W module i urządzeniu nim sterującym muszą być ustawione takie same parametry 

transmisji! 
 

Uwaga: Aby zmienić adres płytki lub prędkość komunikacji, należy ustawić żądany adres 

i prędkość, a następnie wyłączyć i włączyć zasilanie. Zmiana adresu przy włączonym zasilaniu 

nie odniesie skutku aż do następnego wyłączenia i włączenia zasilania. Ustawienie adresu 

płytki na 0 spowoduje nieprawidłową pracę modułu. 
 

5. Konfiguracja 

 

5.1. Protokół transmisji danych 
Moduł komunikuje się z urządzeniem sterującym za pomocą protokołu Modbus RTU. W warstwie 

fizycznej połączenie jest realizowane za pomocą interfejsu RS-485 2W, half-duplex 

(z przełączaniem kierunku transmisji). Rejestry 1100..1102 są rejestrami 3x – Input Registers, 

natomiast wszystkie pozostałe to Holding Registers – 4x. 

 

      Tabela 5. Parametry transmisji w trybie RTU: 

prędkość: 9600/57600 baud (przełączane zworką) 
parzystość: Even 

ilość bitów danych: 8 

ilość bitów stopu: 1 

 

      Tabela 6. Parametry transmisji w trybie ASCII: 

prędkość: 9600/57600 baud (przełączane zworką) 
parzystość: Even 

ilość bitów danych: 7 

ilość bitów stopu: 1 

 

      Tabela 7. Rejestry Modbus i ich znaczenie w czujniku temperatury: 

Numer rejestru Nazwa Opis 

1100 Autokonfiguracja Rejestr do autokonfiguracji 

1101 Ilość czujników Ilość czujników temperatury 

podłączonych do modułu 

1102 Wersja FW Wersja firmware modułu 
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1200 Znak 1 0: temperatura dodatnia,   

1: temperatura ujemna 

1201 Część całkowita temperatury 1  

1202 Część ułamkowa temperatury 1  

1203 Znak 2  

1204 Część całkowita temperatury 2  

1205 Część ułamkowa temperatury 2  

1206 Znak 3  

1207 Część całkowita temperatury 3  

1208 Część ułamkowa temperatury 3  

1209 Znak 4   

1210 Część całkowita temperatury 4  

1211 Część ułamkowa temperatury 4  

1212 Czas pomiędzy odczytami Ustawiany, domyślnie 1s 

1213 Błąd Pojawienie się wartości innej 

niż zero sygnalizuje błąd. 

1214 Ilość wykrytych czujników  

1215 MSB 

1216  

1217  

1218 

Numer seryjny czujnika 1 

LSB 

1219 MSB 

1220  

1221  

1222 

Numer seryjny czujnika 2 

LSB 

1223 MSB 

1224  

1225  

1226 

Numer seryjny czujnika 3 

LSB 

1227 MSB 

1228  

1229  

1230 

Numer seryjny czujnika 4 

LSB 

1231 Znacznik programowania 

konfiguracji 
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Przykład: 
Adres 1100: 109 

Adres 1101: 4 

Adres 1102: 207 

Adres 1200: 0 

Adres 1201: 21 

Adres 1202: 2 

Adres 1203: 1 

Adres 1204: 25 

Adres 1205: 9 

Adres 1206: 0 

Adres 1207: 7 

Adres 1208: 2 

Adres 1209: 1 

Adres 1210: 0 

Adres 1211: 2 

Adres 1212: 2 

Adres 1213: 0 

Adres 1214: 4 

Adres 1200: 0123h (h - szesnastkowo) 

Adres 1201: 4567h 

Adres 1202: 89ABh 

Adres 1203: CDEFh 

Adres 1204: 1234h 

Adres 1205: 5678h 

Adres 1206: 9ABCh 

Adres 1207: DEF0h 

Adres 1208: 2345h 

Adres 1209: 6789h 

Adres 1210: ABCDh 

Adres 1211: EF01h 

Adres 1212: 3456h 

Adres 1213: 789Ah 

Adres 1214: BCDEh 

Adres 1214: F012h 

 

Moduł pomiaru temperatury (109), podłączone 4 czujniki, wersja firmware 2.0.7; 

temperatura odczytana z czujnika 1: +21,2ºC, z czujnika 2: -25,9ºC, z czujnika 

3: +7,2ºC, z czujnika 4: -0,2ºC, pomiar temperatury co 2s, brak błędów, wykryto 

4 czujniki, numer seryjny 1 czujnika: 0x0123456789ABCDEF, numer seryjny 2 

czujnika: 0x123456789ABCDEF0, numer seryjny 3 czujnika: 0x23456789ABCDEF01, 

numer seryjny 4 czujnika: 0x3456789ABCDEF012. 

 

Uwaga: Podane numery seryjne nie są rzeczywistymi numerami seryjnymi czujników - zostały 

pokazane jedynie jako przykład. 
 

5.2 Konfigurowanie modułu do współpracy z czujnikami 
 

Czujniki DS18B20 posiadają unikalne numery seryjne, po których są rozpoznawane przez moduł 

pomiaru temperatury. Numery te nie są umieszczone na obudowach czujników, więc nie da się 
połączyć konkretnego czujnika z jego numerem w module. Dodatkowo, w przypadku gdyby np. 

jeden z czujników przestał działać, wtedy  po następnym uruchomieniu urządzenia inny 

z czujników (o numerze seryjnym niższym niż ten uszkodzony) przejmie jego rejestry w module. 

Może to spowodować niespodziewane  efekty, gdy czujnik mierzący temperaturę w piwnicy 

zostanie przypisany do salonu.  

 

Aby zapobiec takim sytuacjom, od wersji 2.0.4 modułu pomiaru temperatury został wprowadzony 

tryb programowania konfiguracji. Po podłączeniu wszystkich czujników do modułu i uruchomieniu 

komunikacji po Modbusie do rejestru 1231 ("Znacznik programowania konfiguracji"), należy 

wpisać wartość 0xAA, czyli 170 dziesiętnie. Ta operacja powoduje zapisanie konfiguracji 
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czujników w wewnętrznej pamięci modułu. Gdy potem czujnik ulegnie uszkodzeniu – tak, że nie 

będzie rozpoznawany przez moduł, nie spowoduje to przesunięcia się pozostałych czujników 

w tabeli modułu. Natomiast w rejestrach uszkodzonego czujnika pojawi się wartość 255,255,255, 

co oznacza błąd odczytu. Ponieważ prawidłowe wartości rejestru „Znak” to 0 lub 1, program 

użytkownika może łatwo wykryć błąd. Po wymianie czujnika należy ponownie przeprowadzić 
proces programowania konfiguracji.  

 

Uwaga: Ilość dopuszczalnych cykli programowania konfiguracji jest ograniczona, dlatego po 

każdej wymianie czujnika można programować konfigurację tylko raz. W szczególności 

niedopuszczalne jest dodawanie programowania konfiguracji do normalnej tabeli Modbusa 

używanej do komunikacji w systemie. Spowoduje to wyczerpanie dopuszczalnej ilości cykli 

programowania i uszkodzenie urządzenia w czasie krótszym niż 7 minut. 
 

 

5.3. Przykład podłączenia modułu pomiaru temperatury do sterownika 

PLC Fatek 

 
Aby nawiązać komunikację z modułem poprzez port RS-485, należy najpierw skonfigurować port 

w sterowniku PLC. Możemy tego dokonać za pomocą programu  WinProLadder. 

 

Wybieramy z menu PLC → Setting → Port (numer portu, po którym będzie odbywała się 
komunikacja)  

 

 
 

Rys. 5. Wybór portu komunikacyjnego w sterowniku PLC 

 

Po wybraniu odpowiedniego portu następnie musimy go skonfigurować. Ustawiamy parametry 

transmisji w trybie RTU: 

1.) prędkość (Baud Rate):    9600/57600 (ustawiane zworką)  
2.) parzystość (Parity)   even 

3.) ilość bitów danych (Data Bit):   8 

4.) ilość bitów stopu: (Stop Bit)  1 

5.) protokół      Modbus RTU (slave) 
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Rys. 6. Konfiguracja portu komunikacyjnego sterownika PLC, w trybie RTU 

 

Po wybraniu odpowiedniego portu musimy go skonfigurować. Ustawiamy parametry transmisji 

w trybie ASCII: 

1. prędkość (Baud Rate):    9600/57600 (ustawiane zworką)  
2. parzystość (Parity)   even 

3. ilość bitów danych (Data Bit):   7 

4. ilość bitów stopu: (Stop Bit)  1 

5. protokół      Modbus ASCII (slave) 

 

 
Rys. 7. Konfiguracja portu komunikacyjnego sterownika PLC, w trybie ASCII 
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Sterownik ustawiony jako „master” musi mieć uruchomioną funkcję M_BUS (funkcja 150). 

W funkcji 150.M_BUS użytkownik ustawia tylko port, którego będzie używał do komunikacji, 

rejestr startowy programu do komunikacji oraz rejestr roboczy.  

 

Funkcja 150.M_BUS 

 
Rys. 8. Symbol funkcji M_BUS 

 

 

Pt: Numer portu, który ma być użyty do komunikacji 

SR: Rejestr startowy  

WR: Rejestr roboczy  

Jeżeli wejście A/R = 0   - protokół Modbus 

Jeżeli wejście A/R = 1   - protokół Modbus ASCII 

Jeżeli wejście ABT zmieni się na 1, operacja zostaje przerwana i po jej wznowieniu przesyłanie 

zaczyna się od pierwszego pakietu danych. 

 

Kiedy już zostanie skonfigurowany port oraz wstawiona funkcja 150.M_BUS,  musimy stworzyć 
tabelę. Z menu wybieramy Project → Modbus Master Table → Add Modbus Master Table. 

 

 

 
Rys. 9. Widok ekranu przy wstawianiu z menu tabeli do obsługi Modbusa w programie 

WinProladder. 
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Rys. 10. Widok ekranu przy wstawianiu z drzewa konfiguracji tabeli do obsługi Modbusa  

w programie WinProladder. 

 

 

Po wybraniu Add Modbus Master Table pojawi się okno Table Edit.  

 

 

 
Rys. 11. Okno konfiguracji funkcji Modbus w sterowniku PLC. 

 

 

W polu Table Name użytkownik może wpisać dowolną nazwę np. Modbus, natomiast 

w polu Table starting address należy wpisać rejestr startowy, który został użyty w programie 

w funkcji 150.M_BUS, np.: R1000. Następnie po pojawieniu się okna Modbus Master Table można 

dodawać komendy.  
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Rys. 12. Okno edycji komend w komunikacji Modbus 

 

Po naciśnięciu przycisku Add pojawia się okienko „Command Item”, w którym należy wprowadzić 
numer stacji Slave Station (adres naszego czujnika) inny niż numer stacji „master”, na której używa 

się funkcji M_BUS. Następnie wybrać rodzaj komendy, rozmiar przesyłanych danych, adres 

startowy w sterowniku „master” oraz adres startowy w czujniku (lub innym urządzeniu) „slave”. 

 

 

Przykładowa konfiguracja (odczyt temperatury): 
Slave Station:   2 (adres fizyczny modułu równy 2) 

Command:    Read 

Data Size:   12 (4 czujniki) 

Master Data Start Address: np.: R400 (odczytuje wartości z modułu do tych rejestrów) 

Slave Data Start Address: np.: 401200  

 

Przykładowa konfiguracja (zmiana czasu odczytu): 
Slave Station:   2 (adres fizyczny modułu równy 2) 

Command:    Write 

Data Size:   1  

Master Data Start Address: np.: R412 (zapisuje wartości z modułu do tych rejestrów) 

Slave Data Start Address: np.: 401212  

 

Przykładowa konfiguracja (odczyt błędu i ilości czujników): 
Slave Station:   2 (adres fizyczny modułu równy 2) 

Command:    Read 

Data Size:   2  

Master Data Start Address: np.: R413 (odczytuje wartości z modułu do tych rejestrów) 

Slave Data Start Address: np.: 401213  
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5.4. Przykład podłączenia modułu pomiaru temperatury do panelu HMI 

 
Aby nawiązać komunikację z modułem poprzez port RS-485, należy najpierw skonfigurować port 

w panelu HMI. Możemy tego dokonać za pomocą programu  „EasyBuilder 8000”. Wybieramy 

z menu Edit → System Parameters…. 

 

 
Rys. 13. Okno do dodawania urządzeń podłączanych do panelu HMI 

 

Następnie klikamy na „New…”, w efekcie czego pojawi się okno jak na rysunku poniżej: 

 

 
Rys.14. Okno do edycji parametrów komunikacji 
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Możemy teraz ustawić parametry komunikacyjne urządzenia. Chcąc komunikować się po Modbus 

należy w danych polach wybrać: 
 

PLC type - typ komunikacji:  MODBUS RTU 

PLC I/F - typ portu, po którym będzie odbywać 
się komunikacja: 

RS-485 2W 

PLC default station no. 
adres sprzętowy  

modułu temperatury 

COM 
numer i ustawienia portu, przez który odbywa 

się komunikacja panelu HMI z modułem. 

 

Aby ustawić te parametry, należy kliknąć na pole Settings… i wybrać odpowiednie wartości: 

 

1. COM (numer portu komunikacyjnego):  COM 1 

2. Baud rate (prędkość komunikacji):   57600  

3. Data bits (ilość bitów danych)   8 Bits 

4. Parity (parzystość):    Even 

5. Stop bits (ilość bitów stopu):    1 Bit 

 

 
Rys.15. Ustawienia portu komunikacyjnego 

 

 

Przykładowa konfiguracja: 

 
A) Odczyt temperatury: część całkowita 

 

Aby odczytywać żądaną wartość z modułu, należy utworzyć odpowiedni obiekt w panelu HMI, 

wyświetlający tę wartość.  
 

W tym celu wybieramy: menu Objects → Numeric/ASCII → Numeric Display 
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Rys. 16. Tworzenie obiektu Numeric Display 

 

 

Pojawi się okno Numeric Display Object’s Properties, w którym w celu odczytu temperatury 

należy: 

 

W zakładce „General” wybrać: 
• Description        (własny opis obiektu) 

• PLC name:        MODBUS RTU 

• Device type:        4x 

• Address (numer rejestru, który chcemy odczytać):   1204 

(1204 dla temperatury) 

 

 

 
Rys. 17. Właściwości obiektu Numeric Display 

 

W zakładce „Numeric Format” należy wybrać: 
1. Data Format:  32-bit Float 

2. Mask:   Odznaczyć 
3. Left of decimal Pt: 3  (część całkowita) 

4. Right of decimal Pt: 4  (część ułamkowa) 
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Rys. 18. Właściwości obiektu Numeric Display 

 

Po zatwierdzeniu ustawień możemy ulokować obiekt w dowolnym miejscu przestrzeni roboczej 

programu EasyBuilder. Po załadowaniu programu do panelu HMI można już odczytywać 
temperaturę.  
 

W celu zmiany czasu próbkowania należy wykonać tę samą procedurę co powyżej, z tą różnicą, że 

nie wybieramy już obiektu wyświetlającego dane, tylko obiekt odpowiedzialny za wpisywanie 

danych, czyli „Numeric Input”. W skrócie: 

 

W zakładce „General” wybrać: 
Description         (własny opis obiektu) 

PLC name:        MODBUS RTU 

Device type:        4x 

Address (numer rejestru przechowujący czas między odczytem): 1203 

 

 
Rys. 19. Właściwości obiektu Numeric Display 
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W zakładce„Numeric Format” należy wybrać: 
Data Format:  16-bit Unsigned 

Mask:   Odznaczyć 
Left of decimal Pt: 3  

Right of decimal Pt: 0  

 

 
Rys. 20. Właściwości obiektu Numeric Display 

 

Po zatwierdzeniu ustawień możemy ulokować obiekt w dowolnym miejscu przestrzeni roboczej 

programu EasyBuilder. Po załadowaniu programu do panelu HMI można już odczytywać część 
całkowitą temperatury z czujnika numer 1. 

 

B) W celu wyświetlenia innej wartości mierzonej przez moduł należy powtórzyć całą tę procedurę, 
zmieniając tylko numer rejestru odpowiedzialnego za daną wielkość z modułu. Na przykład 

chcąc sprawdzić, czy wystąpił błąd podczas pomiaru, należy w polu „Address” wpisać wartość 
1213. 

 

C) W celu zmiany czasu próbkowania należy wykonać tę samą procedurę co powyżej, z tą 
różnicą, że nie wybieramy już obiektu wyświetlającego dane, tylko obiekt odpowiedzialny za 

wpisywanie danych, czyli „Numeric Input”. 
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5.5. Wymiary modułu pomiaru temperatury  
 
Płytka drukowana ma wymiary: 37x36mm, wysokość maksymalna: 17mm. 

 

 
Rys. 21. Wymiary płytki drukowanej 

 

 

6. Uwagi końcowe 

 
1. Producent zastrzega sobie prawo do wprowadzania ciągłych poprawek i ulepszeń. 
2. Produkt może nieznacznie różnić się od fotografii. 

3. Instrukcja może zawierać błędy. Producent nie odpowiada za jakiekolwiek uszkodzenia, które 

mogą z nich wyniknąć. Jednocześnie producent oświadcza, że dołoży wszelkich starań, by 

żadne błędy w instrukcji się nie pojawiły, a jeżeli tak się stanie, to informacje o wszelkich 

błędach zamieści na swojej stronie internetowej.  

4. Producent nie odpowiada za żadne szkody wynikające z użytkowania urządzenia. 

5. Aktualna wersja instrukcji znajduje się na stronie www.esea.pl . 

6. Wszelkie uwagi dotyczące urządzenia oraz tej instrukcji oraz pytania w sprawach technicznych 

nie wyjaśnionych wyżej proszę kierować na e-mail: info@esea.pl. 


